
 

 

How to produce an index 

 

The index is a list of important terms, concepts, people, places, and events referred to in your book; it is provided for easy 

reader reference. Another way to think of it is as a conceptual map of your book. You can provide us with an index in one 

of three ways:  

Method A (PREFERRED): By marking each one of the index entries where they occur within the MS Word 

document of your manuscript at the time of final manuscript submission, so we can then produce an index 

automatically (see detailed instructions below). 

*OR*  

Method B: By providing us with a manually produced final index in Word format after your book has been 

typeset and the camera-ready PDF proofs are ready, so that the page references will be correct.  

Please contact us to advise if you intend to use this method. We reserve the right to reject indexes produced with 

this method without prior approval. 

* OR (as a very last resort) * 

Method C: By providing us with a list of terms (without page numbers) which must exactly follow the guidelines 

below (only for simple indexes, as it cannot support page ranges).  

Please contact us to advise if you intend to use this method. We reserve the right to reject indexes produced with 

this method without prior approval. 

Each method is explained below in detail. Our strong recommendation is to use Method A. Please contact us for approval 

if you intend to use Method B or Method C. 

IMPORTANT INFORMATION 

 These are the only acceptable methods of delivery. If you don’t follow one of them exactly as explained here, then 

your index will be rejected and your book will not be published until a correct index is supplied. 

 We recommend keeping the index simple and short. As a rule of thumb, every 60 pages of text should correspond 

to approximately one full page of index entries, including all page number references (i.e. a 240-page book should 

have an index of approximately 4 pages in length). 

 We cannot accept a manually-produced index (i.e. Method B) before your manuscript has been typeset, as page 

numbering will change completely following typesetting. You must wait until the PDF proofs are ready and 

approved and then produce the index according to Method B. 

 If you want your index to refer to ranges of pages (e.g.  Octopus, 23-31; 103-111; 254-258) then you must use 

Method A or Method B. Method C is only for simple indexes, it should be only used as a last resort and will not 

be accepted if your index contains page ranges. 

 

Method A – Marking the entries within MS Word 

MSWord includes helpful functionality for producing an index. This is the preferred method of index delivery as it 

minimizes the possibility of errors, can be automatically updated in follow-up editions, and shortens time to publication. At 

its most basic (which should be sufficient for the majority of manuscripts) it is very simple.  



 

 

All you have to do is:  

1. Select the word(s) you want to appear as an index entry in Word (by double-clicking over single words, or clicking 

and dragging the mouse over multiple-word phrases), as pictured below. 

 
2. Then click on the “Mark Entry” button (found under the “References” tab in recent versions of Word), as pictured 

below. Alternatively, you may use the keyboard combination Alt + Shift + X to ‘tell’ Word that you would like to 

include this in the list of index entries.  

 

3. A pop-up window appears titled “Mark Index Entry”, as pictured below. If you only want this particular instance 

of the term to be included in the index, then you can click “Mark”. Otherwise, if you want all instances of the same 

term to be marked in your manuscript as entries in the index, then you have to click “Mark All” (Please use this last 

option judiciously – do you really want all instances of this term to appear on the index?) 

 

 Please be aware: this feature is sensitive to capitalization i.e. if you have the terms ‘euripidis’ and ‘Euripidis’

 in the text, these will automatically form two different index entries. Ensure that you choose the same 



 

 

capitalization when creating entries for ‘euripidis’ and ‘Euripidis’ to avoid double-entries in your index i.e. complete 

the ‘Main entry’ field with ‘Euripidis’ for all examples of ‘euripidis’ and ‘Euripidis’ in the text.  

 

Please note: This is also the case with names. To avoid two different/ double index entries, ensure that the same 

format ‘Surname, Name’ is entered in the ‘Main entry’ field i.e. ‘Crystal, David’.  

 

To confirm that the entry has been successfully added you can temporarily enable a Word ‘view’ that shows hidden 

formatting symbols. You enable this view by pressing the ¶ symbol in the ‘Home’ tab of MS Word (see screenshot 

below) or the keyboard combination Ctrl + *. You should then see some code (e.g. {·XE·"euripidis"·}) next to the entry 

you have marked, which reassures you that the entry has been successfully inserted. This code will not be printed and only 

appears when you enable the viewing of hidden formatting symbols. This code contains the information required to later 

produce an index automatically. Pressing the ¶ symbol again on the ‘Home’ tab disables that view.  

 

4. You have to repeat steps 1-3 until you have marked all terms you want to be included in the index, one by one 

(remember if you want to mark all instances of a particular term to select “Mark All” in the pop-up window).  

 

That’s all!  

 

Make sure you save your document. Once we receive it, we will use the information you marked to produce an 

index automatically. 

 

5. OPTIONAL: If you want to preview what the complete index will look like you can position the blinking cursor 

at the end of your manuscript and then click the “Insert Index” button (also under the ‘References’ tab, see 

screenshot below). An index will be automatically produced. Please note that this will show you a preview of the 

index with all the entries and page numbers included but the exact final index will vary in formatting (font, indent, 

paragraph arrangements) after your book has been typeset. You will of course get a chance to confirm that the index 

is to your satisfaction when you inspect your book’s camera-ready proofs. 

 

If any of the above is unclear, you can find more detailed instructions here:   



 

 

https://support.office.com/en-US/article/create-an-index-and-update-an-index-cc502c71-a605-41fd-9a02-cda9d14bf073   

The link also provides instructions in case you want to mark words or phrases for text that spans a range of pages (optional). 

However, it is not necessary to include these more complex index entries in your index and you should only do so if you 

absolutely want page ranges included. 

 

Method B – Manually producing the final index in Word after your manuscript has been typeset 

This method should only be used with prior agreement.  

This method is only feasible after your book’s camera-ready PDF proofs have been produced and approved by you, so 

that we can be sure that there will be no further changes in page numbers.  

The steps are as follows: 

1. We send you the camera-ready proofs of your manuscript (typeset with our font, layout etc.) which you inspect 

and approve. After this stage your camera-ready proofs are exactly as they will appear in print and no further 

changes are possible. 

2. Make sure you have the very final PDF of the proofs in your possession (after all changes have been 

implemented). Ask your editor for confirmation that the PDF you are working from is the final version. 

3. Produce an index manually in Word (or hire a professional indexer to do it for you), with a list of all the terms as 

they appear in your proofs. Share it with us within the timeframe agreed with your editor (typically 2-3 weeks). 

The index should be in its final form, with all terms, page numbers, page ranges etc. included, ready to be 

appended to your manuscript. 

 

Method C – Providing us with a manually produced detailed list of entries (this method cannot produce page 

ranges)  

This method should only be used with prior agreement. 

With this method you have to provide us with a list of terms which we can later convert into an index. For simple indexes 

(which should be sufficient for most manuscripts) you can simply provide us with a list of words or phrases exactly as they 

appear within the text. We will then produce an index automatically by marking all instances of the terms provided in the 

text. Please note, however, that indexes produced from simple lists won’t mention synonyms, won’t have sub-entries, and 

won’t mark terms discussed over a range of pages.   

If you believe your manuscript requires a more complex index (such as a different entry in the index depending on where 

the phrase appears within the text or sub-entries etc.) then you should only use Method A or B, discussed above. Otherwise 

you have to provide us with a two-column list to help us produce a more complex index. The left column should have the 

words/phrases exactly as they appear within the text. The right column should have the words/phrases the way you would 

like them to appear in the index.  

If a term is a sub-entry, then you have to separate the text in the right column of the concordance list with a colon (:). Word 

will treat any words that come after the colon as a sub-entry in the index. For example: main-entry:sub-entry. (You can find 

more detailed instructions here: http://www.howtogeek.com/howto/35495/how-to-create-an-index-table-like-a-pro-with-

microsoft-word/ ) 



 

 

Additionally, if a phrase repeats itself many times within the text but you want only specific instances of it in the index, 

then you should provide us with more of the surrounding text in the specific instance you want it to appear in the index. 

Take for example the word “octopus” in the below text: 

 

The common octopus would be unique for its appearance alone, with its massive bulbous head, large eyes, and 

eight distinctive arms. But by far the most striking characteristic of the octopus is the wide array of techniques it 

uses to avoid or thwart attackers. 

Defensive Adaptations 

Its first—and most amazing—line of defense is its ability to hide in plain sight. Using a network of pigment cells 

and specialized muscles in its skin, the common octopus can almost instantaneously match the colors, patterns, 

and even textures of its surroundings. Predators such as sharks, eels, and dolphins swim by without even noticing 

it. 

When discovered, an octopus will release a cloud of black ink to obscure its attacker's view, giving it time to swim 

away. The ink even contains a substance that dulls a predator's sense of smell, making the fleeing octopus harder 

to track. Fast swimmers, they can jet forward by expelling water through their mantles. And their soft bodies can 

squeeze into impossibly small cracks and crevices where predators can't follow. 

(Source:  http://www.nationalgeographic.com/animals/invertebrates/c/common-octopus/ ) 

If you want to include every page that mentions the word “octopus” then you just add the term in your list as it is (octopus) 

but if you want the index to point only to the instance of “octopus” that appears in the first paragraph then you should add 

it as follows: 

 

The common octopus would be unique 

octopus 

 

That way the index will only show the page that includes the first paragraph, as long as the whole phrase does not repeat 

itself within the text.  

Please note that we can only guarantee that an entry will appear in the index if you provide them to us exactly as they 

appear in the text. 

 

COMMON ERRORS TO AVOID 

When compiling your index, please ensure that it does not include instances of the following common errors: 

Double entries: 

 Ensure that there are no instances of repetition of authors’ names i.e. one entry including the author’s first and 

surname, and a separate entry of the author’s surname only. 

o For example:  

Austen, 26, 31, 34 

Austen, Jane, 23, 25, 26, 31, 34 

Please make sure that when providing the author’s name as an index entry that it follows the ‘surname, first 

name’ format and is alphabetized by surname.  

 



 

 

 Ensure that there are no entries that are repeated using both the singular and plural forms. Please combine the two 

entries in the singular form.  

o For example: 

novel, 7, 12 

novels, 7, 8, 12, 16 

 

 Ensure that there are no discrepancies in the form/ punctuation of terms, resulting in the repetition of index 

entries (unless the difference in punctuation is used to signal a distinction in meaning.) Please combine them in 

one index entry. 

o For example: 

multiparty, 164, 165 

multi party, 164, 166, 167 

multi-party, 167  

 

 Ensure that there are no double entries where you have two terms for the same concept – one spelled-out in full, 

and the other abbreviated or as an acronym. 

o For example: 

United States of America, 100, 108 

USA, 100, 104, 105, 108 

Please list the entry under the term that you think a reader would be most likely to search for.  

 

Style: 

 Ensure that all index entries, other than proper nouns, begin with lower-case letters.  

 

Changes: 

 

 Please do not make manual changes to the index after it has been generated i.e. delete double entries rather than 

combining them. This causes a discrepancy in the index entries, which is still visible in the code.  

 

 

 

 


